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Abstract
Environmental cues such as day length and temperature contribute to timing of
biological rhythms in seasonal breeders. Life-history transitions such as spring
emergence from hibernation, migration, or mating must be coordinated with
environmental conditions or survival is compromised. Therefore, there must be
chemical signaling pathways in the brain that transduce seasonally-changing
sensory inputs into signals that initiate a hormonal cascade, culminating in
reproductive behavior. The relative importance of environmental cues to
reproductive timing varies with species, time of year, and sex, and the mechanisms
driving these differences remain unknown. The role of photoperiod in regulating
reproductive behavior has been explored in birds and mammals, but much less is
known about the role of so-called supplementary cues such as temperature, which is
crucial in the timing of ectotherm reproduction. This is a critical gap in our
knowledge, because shifts in seasonal temperatures due to climate change could
create a mismatch between peak reproductive behavior and resources necessary for
gestation and offspring survival. Deiodinase 2 (DIO2) enzyme is a critical
component of the pathway that mediates reproduction in photoperiod-activated
seasonal breeders, but whether deiodinase 2 is sensitive to seasonal changes in
environmental temperature is unknown. In this study, we used an ectothermic
vertebrate known to be a temperature-activated seasonal breeder, the red-sided
garter snake (Thamnophis sirtalis parietalis), to investigate changes in hypothalamic
DIO2 in response to hibernation at 4°C and 12°C. We captured male and female
snakes in Manitoba, Canada as they returned to their winter den site from summer
i

feeding grounds. Snakes were hibernated in complete darkness at either 4 °C or 12
°C for up to 16 weeks. A subset of each sex and temperature group were euthanized
at intervals, and the brains collected and processed for DIO2
immunohistochemistry. DIO2-specific staining was found in the anterior
hypothalamus, in the periventricular hypothalamic nucleus and ventral pre-optic
area, along the longitudinally central region of the olfactory tract, in the bed nucleus
of the stria terminalis, caudally in the cortex and optic tectum, and in the lateral
septal nucleus. DIO2-stained area in the anterior hypothalamus was quantified. Male
T. sirtalis in both the 4 °C and 12 °C groups were found to have an increase in DIO2specific staining in the anterior hypothalamus after 8 weeks in hibernation. Female
T. sirtalis were found to have an increase in DIO2-specific staining in the anterior
hypothalamus after 8 weeks in the 12 °C group only. These findings shed light on the
neuroendocrine pathway through which environmental cues other than
photoperiod influence the timing of seasonal reproduction, and support the
hypothesis that at least some components of this pathway are conserved across
seasonal breeders.
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Introduction
Environmental cues such as day length and temperature contribute to timing
of biological rhythms in seasonal breeders (Moore et al. 1984; Dawson et al., 2001;
Woodfall et al.,1994). Life-history transitions such as spring emergence from
hibernation, migration, or mating must be coordinated with environmental
conditions or survival is compromised. For example, emerging from hibernation
before the end of winter, moving from one feeding ground to another before food
sources are ready, or giving birth to offspring when food sources are suboptimal,
could all mean death for an organism or its offspring. Because animals that
reproduce in a specific season each year must coordinate the timing of reproduction
with the environmental conditions in which they live, it makes sense that they use
physical cues from the environment around them to indicate when it is appropriate
to transition to a reproductively active state. Therefore, there must be chemical
signaling pathways in the brain that transduce seasonally-changing sensory inputs
into cues that initiate a hormonal cascade, culminating in reproductive behavior.
The relative importance of environmental cues to reproductive timing varies
with species, time of year, and sex, and the mechanisms driving these differences
remain unknown. Most of the research into the mechanisms that regulate
differences in the timing of seasonal reproduction is relatively recent, and there is
much yet to be discovered. For some organisms, day length, or photoperiod, is the
primary cue that drives the shift to reproductive behavior. For others, temperature
or social cues are the primary activators of reproductive behavior. In some bird
1

species there is a high level of variability between sexes in how much a given cue
affects reproductive behavior (Ball & Ketterson, 2008).

Figure 1. Diagram of the Hypothalamic-Pituitary-Gonadal axis. GnRH from the hypothalamus
signals the pituitary to release gonadotropins LH and FSH, which in turn signal the gonads to
release sex steroids. Feedback loops to the pituitary and hypothalamus help regulate sex steroid
levels.

Seasonal changes in reproductive physiology are regulated by gonadotropin
releasing hormone (GnRH) (Cho et al., 1998). The hypothalamic-pituitary-gonadal
(HPG) axis (Fig. 1) is the core regulatory pathway through which reproduction is
modulated. Specifically, enzymes produced in the hypothalamus have a regulatory
effect on GnRH, which stimulates reproductive changes in vertebrates by signaling
2

the pituitary to release the gonadotropic hormones luteinizing hormone (LH) and
follicle stimulating hormone (FSH). These gonadotropins in turn stimulate sexspecific increases in sex steroid hormones in the gonads, including estrogen,
progesterone, and testosterone, and triggering gametogenesis in the gonads
(Nakane & Yoshimura, 2014). Though much remains to be discovered, relatively
recent research sheds some light on the less well-understood influence of GnRH in
reproductive behavior.
Seasonal changes in GnRH in the brain are mediated by the thyroid hormone
triiodothyronine (T3), which induces synthesis and release of GnRH. Researchers
have learned a good deal about how GnRH is regulated in animals that use
photoperiod as the primary environmental cue for reproduction: T3 stimulates
release of GnRH, and T3 is regulated by deiodinase enzymes produced in tanycytes
along the third ventricle of the brain (Duarte-Guterman et al., 2014; Lewis & Ebling
2017; Watanabe et al., 2004). Deiodinase 2 (DIO2) enzyme is a critical component of
the pathway mediating synthesis of GnRH in photoperiod-activated seasonal
breeders (Köhrle, 1999). Deiodinase 2 converts less-bioactive thyroid hormone
thyroxine (T4) to highly bioactive T3, and T3 stimulates synthesis & release of GnRH.
Deiodinase 3 inactivates T3, so deiodinase 2 and 3 acting in combination serve as a
potent regulator of GnRH and reproduction. It has been found that these two
deiodinases are modulated by environmental cues to facilitate accumulation of T3 in
the brain, which increases GnRH and in turn mediates the seasonal brain changes
needed for reproductive behavior (de Miera et al., 2014). This pathway has been
studied in mammals, birds, and fish, in which it has been found to be responsive to
3

photoperiod cues (Prendergast et al., 2013; MacDougall-Shackleton et al., 2001;
Nakane et al., 2013).
While most seasonal breeders, such as hamsters and quail, use photoperiod as
their primary environmental cue, many use other environmental cues, such as
temperature, social signals, food availability, precipitation, or water conductivity to
supplement their primary cue (Kirschbaum, 1987; Perfito, 2004). The role of
photoperiod in regulating reproductive behavior has been explored in birds and
mammals, but much less is known about the role of so-called supplementary cues such
as temperature, which is crucial in the timing of ectotherm reproduction (Licht, 1972).
This is a critical gap in our knowledge, because shifts in seasonal temperatures due to
climate change could create a mismatch between peak reproductive behavior and
resources necessary for gestation and offspring survival, such as food sources (Bronson,
2009). This is a topic of increasing concern as climate change alters the timing of
seasonal temperature changes, particularly in temperate regions (McLean & Wilson,
2011).
It is notable that the majority of the animal models used thus far to examine the
reproductive timing pathway have been endotherms. One of the challenges of studying
the effects of temperature on reproductive timing is that the warm-blooded animals
most commonly used for neuroendocrine laboratory experiments can physiologically
regulate their own temperatures, making it difficult to isolate the effects of
environmental temperature. However, ectotherms must rely primarily on behavior for
thermoregulation, making an ectotherm an excellent choice of organism for studying
the relationship between temperature and this mechanistic pathway. It is the aim of
4

this research to identify the impact of temperature on the deidodinase 2 enzyme in the
GnRH pathway of a temperature-activated seasonal breeder. In doing so, this research
will also identify whether reptiles share the same mechanisms that activate seasonal
breeding in other vertebrates. If this is the case, it would provide supporting evidence
that these mechanisms are conserved among vertebrates.
Northern populations of red-sided garter snakes, Thamnophis sirtalis parietalis,
are an ideal animal model for studying this reproductive timing pathway. One
advantage of using these animals is that not only are they ectotherms, but their
seasonal reproduction is exclusively regulated by the so-called “supplemental”
environmental cue of temperature (e.g., Whittier et al., 1987), making them an ideal
organism for investigating this pathway. A great deal of research has been done with
these snakes, so we know their typical hibernation temperatures in the wild are as low
as 1°C (Lutterschmidt et al. 2006). They also have robustly stereotyped mating
behaviors, making it easy to assess behavior and correlate it to biological markers such
as neurohormone and enzyme levels in the brain. Not least, they are numerous in the
wild and can be collected in the numbers needed for this research without damage to
the wild population. In combination, these characteristics make them an optimal choice
of organism for answering the question of whether temperature influences DIO2 in the
same way photoperiod does in other animals.
Our hypothesis is that production of deiodinase 2 in the brain is temperaturesensitive, and that not only will the duration of hibernation correlate with an increase
in deiodinase 2 levels in the brain, but that the increase in deiodinase 2 will be greater
at 4°C than it will be at 12°C. To test this hypothesis, we hibernated male and female
5

red-sided garter snakes at 4°C or 12°C similar to previous studies in this species. We
took baseline tissue samples consisting of whole brains from each group immediately
pre-hibernation, as well as after 4, 8, and 16 weeks of hibernation. The samples were
processed for immunohistochemistry, a method that preserves information about the
location of our peptide of interest, to quantify changes in deiodinase 2 staining in the
hypothalamus. We used the resulting immunostaining as a proxy for directly measuring
DIO2, ie. when DIO2-specific immunostaining in tissue increases, we expect that DIO2
has increased.
The implications of this research are multifold. First, it will utilize a reptile
model to elucidate the pathway by which supplementary environmental cues are
transduced to affect reproductive behavior. Second, by studying this in an animal
that shares a common ancestor with both birds and mammals, it will test the
hypothesis that these pathways are evolutionarily conserved across vertebrates.
Third, it helps ecologists and conservationists make predictions about ways in
which climate change may affect seasonally-reproducing animals. Finally, basic
scientific research that expands our body of knowledge often has applications far
beyond those we are able to anticipate from our limited temporal vantage point, and
this knowledge helps build the foundation for future discovery and innovation.

6

Methods and Materials
These experiments were conducted in the laboratory at Portland State
University with red-sided garter snakes (Thamnophis sirtalis parietalis) collected
from a field site in Inwood, Manitoba, Canada. All protocols were approved by PSU’s
Institutional Animal Care and Use Committee and performed under the authority of
a Manitoba Department of Sustainable Development Scientific Wildlife Collecting
permit.

Field collection
From 16-18 September 2016, we captured snakes by hand as they returned
to their winter den site from summer feeding grounds. Animals were segregated by
sex and housed in outdoor arenas with open tops and 61-cm diameter; water was
provided ad libitum.

Captive care
After capture, 84 males and 40 females (n=124 total) were randomly
selected to be included in this experiment. Each animal was weighed, measured, and
assigned a unique number with which to track the animal throughout this
experiment. Using a code, the numbers were clipped into the ventral scales of each
animal using a corneoscleral punch.
Animals were transported to PSU in pillowcases. Upon arrival at PSU on 21
September, animals were housed in groups of 4 (females) or 8 (males) in 40-liter
aquaria in environmental chambers and acclimated to autumn-like environmental
7

conditions (11:13 h L:D photoperiod, 18:12°C thermoperiod) for 4 weeks. Water
was provided ad libitum.
Beginning on 20 October, animals were hibernated in complete darkness
(0:24 h L:D photoperiod) in humidity-controlled environmental chambers at either
4 °C or 12 °C for up to 16 weeks. Snakes were randomly assigned to each
temperature treatment and sampling period. Water was provided ad libitum for the
duration of hibernation. For tissue sampling, a subset of 12 males was euthanized at
0, 4 , 8, and 16 weeks in hibernation, a subset of 8 females was euthanized at 0, 8,
and 16 weeks in hibernation, and the brains collected for DIO2
immunohistochemistry.

Tissue preparation
Snakes were euthanized with an overdose of sodium Brevital and the brains
collected for immunohistochemistry. The brains were fixed via immersion in 4%
paraformaldehyde in 0.1 M phosphate buffer, pH 7.2, at 4 °C for 18 hours. They were
then transferred to 0.1 M phosphate buffer and stored at 4 °C.
For the purposes of a second, independent part of this project examining
temperature-induced changes in the pituitary gland, we preserved the structural
integrity of the pituitary gland during cryosectioning by leaving the ventral portion
of the skull intact during tissue dissection. We then decalcified the intact ventral
skull by incubating the tissues in a minimum of 15 volumes of 14%
ethylenediaminetetraacetic acid (EDTA) solution (pH 7.2) for 4 days; the solution
8

was changed daily. Test assays confirmed that DIO2-specific binding was minimally
affected by this EDTA treatment (data not shown).
We prepared the brains for sectioning by immersing them in 30% sucrose
solution until saturated, then freezing in cryogenic media in a 2.5 × 2.5 × 0.6 cm
plastic mold. We chilled Isopentane (2-methylbutane) in a 10 cm stainless steel
bowl by nesting the bowl approximately 5 cm into crushed dry ice. We wrote each
animal number on a plastic mold with permanent marker, filled the mold with
cryogenic media, placed the brain in the media, then suspended the bottom of the
mold in the isopentane. The brains were thoroughly frozen after 3 minutes in the
chilled isopentane, after which we wrapped them in Parafilm followed by aluminum
foil. The frozen brains were then stored at -80° C. Brains were sectioned on a
cryostat (Leica 3050S) into 4 alternate series of 25-µm sagittal slices. The slices
were thaw-mounted onto slides (Fisherbrand Superfrost Plus) coated with a gelatin
substrate. These brain tissues were then stored at –20 °C until they were processed
for immunohistochemistry.

Immunohistochemistry
We examined differences in deiodinase 2 among groups via
immunohistochemistry for deiodinase 2 enzyme within the hypothalamus. All slides
were processed in a single assay following the protocols described by Lutterschmidt
and Maine (2014). Slides containing the region of interest (medial hypothalamus)
were defrosted and dried on a slide warmer at 50 °C for at least 30 min, after which
the tissues were outlined with a hydrophobic barrier (Liquid Blocker – Super Pap
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Pen; Electron Microscopy Sciences, Hatfield, Pa., USA). The slide-mounted tissues
were then incubated in 4% paraformaldehyde in 0.1 M phosphate-buffered saline
(PBS; pH 7.4) for 5 minutes to ensure adherence of tissue to slides. Slides were
washed 3 times for 5 min per wash with 0.1 M PBS, followed by fixative
neutralization with 0.1% sodium borohydride (pH 8.5) for 20 min. The slides were
washed again in PBS (3 × 5 min). To reduce nonspecific background staining from
unwanted endogenous peroxidase reactivity with the 3,3'-Diaminobenzidine (DAB)
used in the final staining step, endogenous peroxidase activity was quenched with
1% hydrogen peroxide in 0.1 M PBS for 30 min. The slides were washed in PBS (2 ×
5 min) followed by PBS with 0.3% Triton X (PBS-T; 1 × 5 min) and then incubated
for 60 min in PBS-T containing 10% normal horse serum (item H1270, SigmaAldrich Co.) and 10% Avidin (item SP-2001, Vector Labs, Burlingame, CA 94010,
USA) to reduce nonspecific binding. DIO2 immunoreactivity was examined using a
goat anti-DIO2 antiserum (item ab-77481; Abcam, Cambridge MA 02139-1517,
USA) at a dilution of 1: 2,000 in PBS-T containing 10% normal horse serum (item
G676, Sigma-Aldrich Co.) and 10% biotin (item SP-2001, Vector Labs). Sections
were coverslipped with parafilm and incubated with the primary antibody for 48 h
at 4 °C in a humid chamber. After primary antibody incubation the coverslips were
removed in PBS and the slides washed in PBS (2 × 5 min) followed by PBS-T (1 × 5
min). The primary antibody signal was amplified by incubation for 60 min with
biotinylated horse anti-goat secondary antibody (item BA-9500; Vector Labs)
diluted 1: 400 in 0.1 M PBS-T. The slides were washed in PBS (2 × 5 min) followed
by PBS-T (1 × 5 min). Tissues were incubated for 60 min in avidin conjugated to
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horseradish peroxidase (Elite ABC peroxidase kit; Vector Labs) to complete the
biotin-avidin- HRP amplification step, and rinsed in PBS (2 × 5 min) followed by
PBS-T (1 × 5 min). The specific antibody signal was further amplified by incubation
with 100 µL biotinylated tyramide solution (Item SAT700; PerkinElmer, Waltham,
MA 02451, USA) at a dilution of 1:50 for 60 min; slides were coverslipped with
Parafilm during the incubation period and then washed in PBS (2 × 5 min) followed
by PBS-T (1 × 5 min). The final amplification step was a second incubation with 400
µL avidin- horseradish peroxidase conjugate (Elite ABC peroxidase kit; Vector Labs)
for 60 min. The slides were washed in PBS (2 × 5 min) followed by PBS-T (1 × 5
min). Primary antibody binding was visualized using 0.25 mg/ml 3,3'Diaminobenzidine (DAB) (item 0430-5G; BioExpress, Kaysville, Utah, USA) in 0.2%
hydrogen peroxide in 0.05 M Tris-HCl buffer (pH 7.2). The reaction was terminated
by immersion in nanopure H2O (3 × 5 min). Tissues were dehydrated in a graded
ethanol series (70, 85, 95, 100%, 2 min ea.), cleared with Citrasolv (Fisher Scientific,
Pittsburgh, Pa., USA), and covered with Permount and coverslips.
To confirm that the staining was due to primary antibody specificity to DIO2
in T. sirtalis, we performed a preadsorption assay. Prior to immunohistochemistry,
we incubated diluted DIO2 antibody (1:2000) overnight at 4 °C with synthetic DIO2
peptide (EVKKHQNQEDRC) (item 131396, Abcam,) at a concentration of 50 μg/mL.
We used the same antibody solution with no peptide for a control, using slides
consisting of alternating tissue sections taken from the same animals.
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Immunoreactivity quantification
Animals were coded to ensure that the observer was blind to the treatment
group of each animal. Because individual cell bodies were typically not
distinguishable based on immunoreactive staining, cell counts would not have
yielded an accurate representation of DIO2 presence; therefore, we quantified DIO2specific staining by measuring and summing the area of the staining across the
anterior hypothalamus. After the deiodinase-producing brain cells were
immunohistochemically stained to render them distinct from the background tissue,
we photographed the region of interest in the hypothalamus at 200x using an
Olympus BX40 microscope with a QIClick digital camera and QImaging software
(QImaging; Surrey, B.C., Canada). We endeavored to maintain consistent light
balance for all photos, but some variation was unavoidable, as it was not feasible to
photograph all the sections in the same session. Manual thresholding of the digital
area selection was required to compensate for variation in background and specific
staining, and this also served to adjust for the minor differences in light balance
across photos. This manual thresholding process was validated by taking repeated
measurements from the same sections and comparing the results for similarity; only
inconsequential differences were found between repeated measurements of the
same sections. Because of the necessary subjectivity of manual thresholding, all of
the DIO2-stained area data were collected by the same individual in order to avoid
inter-observer variation. Photography was spread over the span of one week.
We identified an area of the anterior hypothalamus directly superior to the
pituitary as our target region of interest (ROI) for assessing area of DIO2 staining in
12

a sagittally-sectioned brain. For consistency, the area was photographed at 200x
starting when the pituitary sections began to take on a distinctive almond shape,
indicating sections were leaving the lateral margin and approaching the midline,
and ceasing on the other side of the midline when the pituitary once again reduced
to a smaller, more circular shape, indicating that sections were nearing the lateral
margins. This approach helped ensure that we included every section that
represented our region of interest. The inferior margin of the hypothalamus served
as the lower boundary for the photomicrographs. The area of stained tissue in each
section of the hypothalamus was determined using the thresholding tool in ImageJ
software to select all areas that appeared visibly darker than the background
staining of that tissue section to such a degree that we deemed them to be specific
staining. Because levels of background and specific staining varied considerably
from slide to slide, and somewhat from section to section, this process required each
image to be individually thresholded and measured.
In order to avoid artificial inflation or deflation of the stained area, we
developed specific parameters around how to assess animals with very little
staining, medium staining, and a great deal of staining (fig. 2). For animals with little
to no specific staining (mean staining across all measured sections <1000 μm2), we
measured 2-5 medial sagittal sections that we knew should exhibit DIO2-specific
staining. In animals with moderate staining (mean staining across all measured
sections 1000μm2 to 3000μm2), we measured all sections with staining that was
visually distinguishable from background (min 2, max 8). In animals with heavy
staining (mean staining across all measured sections >3000 μm2), we measured all
13

sections with staining that was visually distinguishable from background (min 2,
max 9), but with the additional condition of restricting measurement of the lateralmost sections to those with staining that was at least 16% of the maximum staining
within that same animal. This additional condition served to set firm boundaries on
the sections measured and avoid artificially inflating the sum of the stained area. We
acknowledge that this approach was highly conservative, and may have artificially
decreased the magnitude of the between-groups differences we found.

Figure 2. Example photomicrographs of sagittal sections of T sirtalis brains demonstrating (A)
anatomical location of anterior hypothalamus within the brain, (B) light specific staining, (C)
moderate specific staining, and (D) heavy specific staining for DIO2. Photomicrographs were
taken at 200x magnification.

Each photograph was uploaded into ImageJ software (Fiji 2 download,
ImageJ version 2.0.0-rc-68/1.52e). Before beginning data collection, we used the
Analyze>Set Scale menu function in ImageJ to calibrate the images for the correct
14

microscope magnification. For these images, the calibration for 200x was 3.15 pixels
= 1µm. We then converted all images to 8-bit 256-grayscale images using the
Image>Type>8-bit menu function, to permit the use of the thresholding tool based
on pixel density alone without having to adjust for the additional variables of color
thresholding.
To convert all images to 8-bit and set scale at the same time, we selected
Process>Batch>Macro, selected origin and destination folders, and typed the
following code into the macro box (fig. 3):
run("8-bit");
run("Set Scale...", "distance=3.15 known=1 pixel=1 unit=µm");

Figure 3. Screenshot of batch process window, showing script for setting the scale and converting
the image files to 8-bit grayscale.
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Once the images were calibrated and converted to 8-bit, we began collecting
data. For this, we opened a target image and selected Image>Adjust>Threshold. A
window with a histogram and two slider tools opened. We moved the bottom slider
until all the area that we visually determined was specific staining was captured in
red (fig. 4). We then clicked “Apply”.

Figure 4. Screenshot of the Threshold tool in use, showing the thresholding histogram, slider
tools, and grayscale image, with pixels that are above the selected threshold highlighted in red.

After these selections were applied, the image turned from grayscale to black
and white, with the selected areas shown in black, and background shown in white.
We then selected Analyze>Measure, and our measured area appeared in the
“Results” box. We saved the results as an Excel file, and copy-pasted the measured
stained area from each section into our final master Excel spreadsheet. We
calculated the sum of the measured stained area within the medial hypothalamus of
each animal to quantify the DIO2-specific staining.

16

Statistical Analysis
Male and female T. sirtalis are sexually dimorphic, with females having an
overall larger body size and proportionally larger brain size that could reasonably
be expected to translate to a larger DIO2 stained area. Thus, we analyzed these
groups separately. For females, differences among groups were analyzed with a
two-way analysis of variance, General Linear Model. We adjusted for skewness by
transforming the data using the natural log. The sum of the stained area for each
animal was the dependent variable, and temperature and duration of hibernation
were the between-subjects factors. This transformation of the data met the
assumptions for normality (Shapiro-Wilk P = 0.143) and Equal Variance (P = 0.635).
Significant main effects were further examined with an all-pairwise multiple
comparisons procedure (Student-Newman-Keuls Method).
For males, differences among groups were assessed using the natural log of
the sum of the stained area measurements from each animal as the dependent
variable. Because data transformation could not correct for deviations from
normality and equal variance, we used the non-parametric Scheirer-Ray-Hare
extension of the Kruskal-Wallis ANOVA on ranks. H and P values were then
calculated manually from the mean squares and sum of squares data included in the
ANOVA table. Significant main effects were further examined with a non-parametric
multiple comparisons test.
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Results
Preadsorption results confirmed that our antibody staining is specific for
DIO2: staining was reduced to background levels with preadsorption of the
antibodies by incubating the DIO2 antibody solution with an excess amount of
DIO2 peptide prior to proceeding with immunohistochemistry (fig. 5).
We found DIO2-specific staining in the anterior hypothalamus, in the
periventricular hypothalamic nucleus and ventral pre-optic area, along the
longitudinally central region of the olfactory tract, in the bed nucleus of the stria
terminalis, caudally in the cortex and optic tectum, and in the lateral septal nucleus.
Other than our examination of the anterior hypothalamus, the meaning of DIO2
presence in these areas remains unknown. We selected the stained area in the
anterior hypothalamus for quantification purposes, as this population of DIO2producing cells is most directly relevant to our hypothesis about temperatureinduced changes in DIO2 regulating GnRH and seasonal reproduction.

Figure 5. Example photomicrographs from deiodinase II (DIO2) antiserum preadsorption tests in
red-sided garter snakes (T. sirtalis). Immunoreactive staining is shown following preadsorption of
DIO2 antibody (diluted 1:2000) with (A) 50 μg or (B) 0 μg DIO2 peptide per milliliter of
antibody solution.
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Hibernation temperature had a significant effect on DIO2-immunoreactive
stained area (μm2) in the hypothalamus of female T. sirtalis (F1,39=7.184, P=0.011)
(fig. 6). We found that the area of staining was greater in animals hibernated at 12°C
than in animals hibernated at 4°C. Neither the duration of hibernation (F2,39=1.861,
P=0.171) nor the interaction term (F2,39=1.881, P=0.168) significantly affected DIO2stained area (μm2) in the hypothalamus of female red-sided garter snakes.
Hibernation temperature (H1,82=1.176 𝑥10-07, P=1) did not have a significant
effect on the sum of DIO2-specific staining (μm2) in the hypothalamus of male T.
sirtalis (fig. 7). The duration of hibernation (H3,82=15.785, P=0.001) significantly
affected the DIO2-stained area (μm2) in the hypothalamus of males; animals had a
larger sum of DIO2-ir staining (μm2) with longer duration of hibernation. There was
no significant effect of the interaction term on DIO2-stained area (μm2) in the
hypothalamus of male T. sirtalis (H3,82=1.493, P=0.684).
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Figure 6. The sum of DIO2-specific staining in the hypothalamus of female T. sirtalis during
hibernation at 4°C or 12°C. Each bar is the mean + 1 SE. The sum of staining was greater in
animals hibernated at 12°C than in animals hibernated at 4°C. As expected, there was no
difference between temperature groups at week 0 (P=0.874), but there was a significant
difference between temperature groups at week 8 (P=0.016) and week 16 (P=0.005). Asterisks
indicate significant differences between temperature groups within each sampling time.

Figure 7. The sum of DIO2-specific staining in the hypothalamus of male Thamnophis sirtalis
parietalis during hibernation at 4°C or 12°C. Each bar is the mean + 1 SE. Duration of
hibernation significantly affected the DIO2-stained area (μm2) in the hypothalamus; animals had a
larger sum of DIO2-ir staining (μm2) with longer duration of hibernation. We found a significant
difference between week 4 and week 8 (P<0.05) and between week 4 and week 16 (P<0.05).
Letters indicate significant differences among sampling times.
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Discussion
The type 2 iodothyronine deiodinase, also known as deiodinase II (DIO2), is a
selenoprotein that converts the relatively less-bioactive thyroid hormone thyroxine
(T4) to its highly-bioactive counterpart triiodothyronine (T3). Increases in DIO2
expression or enzymatic activity lead to a higher rate of T4 conversion, resulting in a
higher local concentration of T3 (Bechtold & Loudon 2007, Köhrle, J. 1999). As
thyroid hormones are used widely in the activation and regulation of physiological
processes including metabolism (Furuya et al. 2010, Medina et al. 2011) as well as
reproduction as previously discussed (Revel 2006, Watanabe et al., 2004,
Yoshimura 2006, 2013), the mechanisms that regulate them are an interesting
target for research with implications that go beyond the model system being
studied.
We found DIO2-specific staining in the anterior hypothalamus,
periventricular hypothalamic nucleus and ventral pre-optic area, along the
longitudinally central region of the olfactory tract, in the bed nucleus of the stria
terminalis, caudally in the cortex and optic tectum, and in the in the lateral septal
nucleus. We found significant differences in the area of DIO2-specific staining in the
anterior hypothalamus over time in both males and females, with DIO2-stained area
increasing significantly between week 4 and week 8 in both 4°C and 12°C
temperature groups in males, and DIO2-stained area increasing significantly at
week 8 within the 12°C temperature group in females. There were no significant
differences between temperature groups in males.
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Question 1: Is Deiodinase 2 in Thamnophis sirtalis parietalis affected by lowtemperature hibernation?
Our results demonstrate that DIO2 in the hypothalamus of red-sided garter
snakes increases over time in response to low-temperature hibernation. This
finding supports the hypothesis that the neuroendocrine pathway that regulates
seasonal reproduction in birds, mammals, and fish is also shared in reptiles,
bringing us considerably closer to confirmation that this is a conserved pathway in
vertebrates.
In photoperiod-activated breeders, DIO2 increases in response to the day
length leading to the season in which they breed; in other words, short-day breeders
show elevated DIO2 in response to a shortened photoperiod, and long-day breeders
show elevated DIO2 in response to an elongated photoperiod (Nakane & Yoshimura,
2014). For example, among Djungarian, Siberian, and Syrian hamsters, all long-day
breeders, DIO2 increases in response to exposure to a long photoperiod
(Prendergast et al., 2013; Revel et al., 2006; Watanabe et al., 2004). Among shortday breeders such as the Saanen goat, DIO2 increases in response to a short
photoperiod (Yasuo et al., 2006). Therefore, the increase in DIO2 seen in response to
cool temperatures in T. sirtalis is consistent with what we would expect to find in a
temperature-activated Spring breeder.
It is interesting that the increases we measured in DIO2-stained area are
seen both at 4°C and at 12°C in male garter snakes, a temperature considerably
higher than those typical during winter hibernation, when the temperature is likely
to dip to below 1°C for sustained periods within the hibernaculum (Lutterschmidt et
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al., 2006). In the area of Manitoba where we collected our animals, 12°C would be
typical of average mid-May or October daytime temperatures (NOAA website, n.d.,
accessed 2019). However, it is notable that the animals require a sustained duration
of several weeks of consistently cool temperatures for the temperature to have an
influence on DIO2, conditions which would normally only occur in their native
region after mid-to-late October, when the snakes are in their underground
hibernaculum.

Question 2: Is deiodinase II sensitive to the duration of low-temperature dormancy?
This research shows that in red-sided garter snakes, DIO2 increases over
time in response to sustained exposure to temperatures at or below 12°C. In order
for this change to occur, it appears that these animals must be exposed to low
temperatures for at least 4 weeks, leading to a rapid increase that is initiated
between week 4 and week 8, and then levels off between week 8 and week 16. This
indicates that there is a threshold effect for the duration of hibernation, in which
snakes require a minimum time of exposure to reduced temperatures before the
effects of the processes that induce DIO2 production are measurable. This is
consistent with previous studies that have found that low-temperature hibernation
is necessary to stimulate the onset of spring courtship behavior in male T. sirtalis
(Gartska et al., 1982), but also that this onset was delayed after hibernation at 10°C
as compared to 5°C (Lutterschmidt & Mason, 2009). Further, there is preliminary
research examining the relationship between courtship behavior and GnRH, which
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found that GnRH-immunoreactive cell count and cell area were significantly
increased at 8 weeks of low-temperature hibernation (Lutterschmidt et al. 2015).

Question 3: Are there sex differences in DIO2 in response to low-temperature
hibernation?
In female T. sirtalis, deiodinase production increases over time in
hibernation, and in contrast to our findings in males, it increases in animals that are
hibernated at 12°C, but not at 4°C. One possibility is that the cool temperatures are
necessary to activate the signaling pathway that results in production of DIO2, but
metabolism is so slowed at 4°C that synthesis of proteins is inhibited. However, this
seems unlikely, as we see increases during hibernation at 4°C in males, indicating
that slowed metabolism alone is not responsible for this difference. An interesting
question is why this large difference in DIO2 staining between temperature groups
is seen in female T. sirtalis, while in males, there are no differences in DIO2-specific
staining between temperature groups.
One possible explanation is sexual dimorphism in the use of DIO2 in this
species. If males use the DIO2-T3-GnRH pathway to regulate courtship behavior,
while females use it later in the season to regulate ovulation and/or fertilization, it
could explain the differences seen here. Perhaps the majority of seasonal DIO2
production in females typically takes place when spring warming begins, after
emergence, because females are using DIO2 to regulate reproductive processes that
are temporally disconnected from spring emergence, courtship, and copulation.
Reproductive activity in T. sirtalis is stimulated by cold-temperature hibernation. If
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females use some other temperature-sensitive mechanism to stimulate sexual
receptivity during Spring emergence, they would not require production of DIO2
during hibernation. If increased DIO2 in females is linked to fertility, and
fertilization occurs with stored sperm during the warmer late Spring and early
Summer months, it would confer no benefit to a female snake to produce DIO2 and
become fertile deep in winter. We know that sexually-attractive females are
emerging from the den with body temperatures well below the 4°C (Lutterschmidt
et al., 2006) that this research shows is too cold for an increase in DIO2 production
to be taking place. This reinforces the likelihood that female attractivity and
receptivity depend on different pathways, and perhaps different environmental
cues, compared to male reproductive behavior.
It is plausible that DIO2 in the hypothalamus of female T. sirtalis increases
when spring temperatures increase as a regulator of timing for vitellogenesis,
ovulation, and ultimately, fertilization. These must be timed correctly for the birth of
neonates to coincide, ideally, with the peak of the summer feeding season, to ensure
their best chance of survival. It is worth noting that the 12°C group did not
experience winter hibernation conditions, and we don’t know if female T. sirtalis
show an increase in hypothalamic DIO2 after Spring emergence, so this remains to
be confirmed. Likewise, it is unknown if they show an increase in DIO2 during the
Fall migration to the hibernaculum. If DIO2 stimulates vitellogenesis, an increase in
DIO2 during the summer and/or Fall, prior to hibernation, could explain the finding
that 80% of female T. sirtalis showed signs of vitellogenesis after low-temperature
hibernation (Whittier et al., 1987).
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Because the experimental animals in the 12°C group did not experience the
low temperatures required for this species to undergo reproductive activation, the
females may not have become sexually receptive or even fertile; this leaves the door
open for further exploration of the physiological functions that are activated by
DIO2. For example, in animals that are cooled only to 12°C, will we see vitellogenesis
but no ovulation?
Experimental evidence has demonstrated that sexual attractiveness can be
induced by hibernating female T. sirtalis at 4°C for at least 4 weeks and injecting
them with estradiol (Crews et al., 1984, Lutterschmidt & Mason 2009). It would be
very interesting to determine whether this treatment also increases DIO2. It is
established in this species that sexual receptivity and fertility are regulated
separately (Crews et al., 1984), and it is interesting that we see an increase in DIO2
under mid-to-late Spring temperature conditions that would occur well before
eventual fertilization will take place. As female T. sirtalis are able to store sperm to
be used when their follicles mature later, and may become gravid a year or more
after mating (Crews et al., 1984), perhaps DIO2 increases are a prerequisite for
post-mating ovulation in female T. sirtalis. If so, it would make sense that DIO2
becomes elevated in response to a temperature that implies that the time to
disperse to Summer feeding grounds has arrived. This timing may help ensure that
gestation will occur over the summer, when a consistent food supply with which to
nourish the developing fetuses is well-established.
Males undergo gametogenesis during the summer and store sperm over
winter for Spring mating; they must be ready to deliver sperm immediately upon
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Spring emergence. While always harshly cold, northern Manitoba winters can vary
in length, and male snakes have to hit the ground running, so to speak. If males use
DIO2 to stimulate courtship behavior, it is in their best interest to start producing
DIO2 as soon as they receive the signal that winter has commenced. This way, the
male will be ready to court and deliver gametes to a receptive female as soon as
spring thaw occurs, whether it occurs early or late in the season.
Most ectothermic vertebrates are capital breeders, relying on stored
resources to support mating and the development of young (Bonnet et al., 1998.).
Northern populations of T. sirtalis parietalis are no exception, and females in this
population are also considered to be biennial breeders, alternating parturient and
non-parturient years (Gregory 2006, Dayger et al., 2018). Although it is thought that
only 50% of the females will reproduce in a given year, 80% of females hibernated
for 7 weeks or more showed signs of vitellogenesis detected via palpation (Whittier
et al. 1987). Photoperiod appears to have an effect on vitellogenesis, with
unseasonably long photoperiod suppressing it, but not on sexual receptivity
(Whittier et al. 1987). Light cues are not required to stimulate reproductive activity
in T. sirtalis (Whittier et al., 1987), so we know there is a solely temperaturedependent component to reproductive activation in this species. Females may be
using light cues alone or in combination with temperature cues to influence follicle
development, but can use temperature alone to stimulate reproductive behavior.
Biennial reproduction may also provide an explanation for at least some of
the variation observed in females in our experiment; if DIO2 is related to female
reproductive condition, we would reasonably expect to see a great deal of variation
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in DIO2. Unfortunately, there is not yet a means in this species for determining
which females will become parturient and which are post-parturient, though this
ability would be extremely useful for researchers investigating reptile reproductive
systems.

Conclusion:
This study was designed to answer the question of whether the reproductive
regulatory pathway of temperature-activated seasonal breeders involves an
increase in DIO2. Finding that the mechanisms of this endocrine pathway are shared
between photoperiod-activated and temperature-activated seasonal breeders
provides evidence that this is a conserved pathway that we can expect to find in
most, if not all, vertebrates. Further, finding that this pathway is shared between
photoperiod-activated seasonal breeders and temperature-activated seasonal
breeders indicates that some animals may use both in conjunction with one another.
This opens the door to the possibility that this pathway may be activated,
moderated, or reinforced by other environmental cues as well, singly or in
combination.

Future directions and Broader Significance
An interesting direction for future research would be to confirm that the
other mechanisms of the seasonal reproductive regulatory pathway in a
temperature-activated breeder are the same as those found in birds and mammals.
In females of the European Starling, DIO2 and DIO3 have been found to work
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together to facilitate switching of the annual reproductive cycle in response to yet
another environmental cue: social signals. The presence of a male causes female
starlings to respond with increasing DIO2, acting as an “on” switch, and DIO3 acting
as an “off” switch by deactivating T3 after DIO2 levels decline (Perfito et al., 2015). A
similarly reciprocal relationship between DIO2 and DIO3 in a reptile model could
elucidate whether this aspect of the pathway is shared across clades.
If these pathways modulating reproductive responses to environmental cues
are indeed common among vertebrates, a more complete understanding of them
will simplify identification of environmental cues used by other species. Urban light
pollution is thought to be having a considerable deleterious effect on urban-adjacent
wildlife populations by interfering with seasonal day-length cues in birds, sea
turtles, and other vertebrates who mate or nest within visible range of city lights
(Falchi et al., 2011; Gaston et al., 2013; Gaston et al., 2015; Longcore & Rich, 2004).
This could be confirmed if the mechanistic pathway posited here is found to be
conserved in vertebrates. Confirmation of these mechanistic pathways could help
inform research on the impacts of both light pollution and climate change on
seasonal reproduction in countless affected species, and may also have hopeful
implications for research aimed at increasing the success rate of artificial
insemination in endangered animals. Agricultural applications along those lines are
also a possibility.
Finally, and most intriguingly, knowledge of the pathways through which
reproduction is regulated could have implications for human reproductive health; a
disconnect or deficiency along the pathway may result in reduced fertility, or in a
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reproductive disorder such as Polycystic Ovarian Syndrome, that reduces the
quality of life as well as the odds of conception for those affected by it. Knowledge of
the involved neurohormonal mechanisms will be helpful for researchers developing
treatments. Finally, one important emerging issue in public health is a pervasive
sperm count decline in Western men, an estimated 58% since the earliest data
available in 1974 (Bonde & Velde, 2017; Levine et al., 2017; Sengupta et al., 2018).
Humans are weakly seasonal breeders, with birth rates that peak in late summer,
between July and September in the US (Foster & Roenneberg, 2008; Lam & Miron,
1994), and this effect becomes more pronounced the more distant a population is
from the equator (Brewis et al., 1996; Roenneberg & Aschoff, 1990), which may
imply that the effect is at least partially photoperiod-driven. A countering
hypothesis is that cold temperatures keep people indoors in close proximity during
midwinter, and that more conceptions occur during this time as a result, but existing
research does not support this (Udry & Morris, 1967) and it is insufficient to explain
the marked increase in conceptions that begins in September, particularly in
temperate regions where September is late summer, a peak harvest season. We
have been very successfully filling our environment with increasing quantities of
short-wavelength light, a very effective mimic of peak daylight. The research
reported in this paper makes a novel contribution to a larger body of work
examining the seasonal reproductive pathway in vertebrates. Taken all together, the
body of work on vertebrate seasonal reproduction supports the biological
plausibility that extended exposure to short-wavelength light could potentially be
interfering with the human reproductive cycle, contributing to endocrine system
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disruption and, perhaps in combination with other environmental pollutants,
leading to reduced sperm production. If this is the case, a thorough knowledge of
these endocrine pathways and the environmental cues that influence them will be
an important part of the puzzle in seeking solutions to this emerging human health
problem.
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